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1 Welcome to COPA-DATA help

ZENON VIDEO TUTORIALS

You can find practical examples for project configuration with zenon in our YouTube channel
(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an
initial insight into working with different zenon modules. All tutorials are available in English.

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you
would like added, please send an email to documentation@copadata.com.

PROJECT SUPPORT

You can receive support for any real project you may have from our customer service team, which
you can contact via email at support@copadata.com.

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com.

2 zenon Science Package for LEGO MINDSTORMS

The zenon Science Package for LEGO MINDSTORMS enables the programming of LEGO
MINDSTORMS NXT and MINDSTORMS EV3 Brick. Programs are created in zenon Logic and executed
on the LEGO Controller with straton. zenon Logic is the programming environment in accordance
with IEC 61131-3 included in zenon.
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This instruction takes you through the installation and programming for the automation of a LEGO
MINDSTORMS NXT 2.0 or MINDSTORMS EV3 Brick with zenon. Only information with regard to the
operation with zenon Logic/straton is contained in this documentation. Please find basic information
on the programming and operation of LEGO MINDSTORMS objects in the LEGO documentation.

All necessary software is included on the installation medium for the zenon Science Package for LEGO
MINDSTORMS. This package does not contain any LEGO hardware, components or controls.

For the configuration of LEGO hardware with zenon use the following software:
»  zenon: Software for monitoring and controlling which contains the integrated zenon Logic.

» zenon Logic Workbench: Programming environment for programs running on the
embedded straton firmware.

» straton: Firmware for the LEGO Controller.

Please find all required applications and information on the installation media. These should already
have been created in your zenon folder on the computer. The most important folders are:

»  FIRMWARE: This folder contains the firmware you can load onto your LEGO MINDSTORMS
Controller with the LEGO Firmware Loader.

P USB_DRIVER: This folder contains the INF file for the USB-to-serial driver.
¥ Information

LEGO, MINDSTORMS, NXT and EV3 are trademarks and products of the
company LEGO.
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3 zenon Science Package for Lego MINDSTORMS 2.0

The zenon Science Package for LEGO MINDSTORMS 2.0 enables the programming of LEGO
MINDSTORMS NXT 2.0 objects. Programs are created in zenon Logic and executed on the LEGO
Controller with straton. zenon Logic is the programming environment in accordance with IEC 61131-3
included in zenon.

3.1 Installation
For using the zenon Science Package for LEGO MINDSTORMS the following is required:
» zenon from version 7.00 SPO on

» Firmware (on page 8) for the LEGO Controller

If you have already installed zenon 7.00 or higher on your computer you will also have a license for
using the zenon Science Package for LEGO MINDSTORMS. If you haven't installed zenon yet install the
zenon version from the installation medium (on page 7). This is a limited License (on page 7) for using
LEGO MINDSTORMS 2.0.

3.1.1 zenon installation

In order to install zenon in the current version:
1. Connect the installation medium to the computer.
If the installation does not start automatically, select start.exe.

Select zenon 8.20.

oW

Follow the instructions of the installation wizard.

Note: If you already have a zenon version from 7.00 on no installation is required.

3.1.1.1 zenon Science Package License

The zenon Science Package for LEGO MINDSTORMS 2.0 is included in the standard zenon license. If
this version is installed on a system without zenon it will run with a zenon Science Package License.
With this license it is also possible to create and edit zenon projects within the scope of the licensed
modules.

This license contains:
» 128 variables
» Extended Trend Starter Edition
»  Historian Starter Edition
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» VBA
» zenon Logic Workbench

P straton firmware

Note: This license is executable for 90 minutes. The Editor must then be closed and re-started.

3.1.2 Demo projects
You also get two demo projects in the COPA-DATA Forum (www.copadata.com/forums
(https://forum.copadata.com/)):

»  MINDSTORMS_DEMO: Gives an overview over sensors and controller. Use this project to
become familiar with LEGO MINDSTORMS 2.0 and its programming.

» LEGO_DEMO_SHOOTERBOT: A sample project for the Shooterbot. This can be adjusted to
your needs.

Load the working area with both projects into zenon:

—

right-click on the current workspace
2. inthe context menu working space select -> Restore backup...
3. Go to the working area backup on the installation medium (*.wsb)
4. select the file and click on OK
To open projects:

1. in the working space go to node zenon Logic (IEC 61131-3)

2. select the node by left-clicking on it

3. select the project mindstorms

4. click on the symbol open in the toolbar or double-click on the project in order to open the
project in the zenon Logic Workbench

3.1.3 Install firmware
In order to be able to use your LEGO MINDSTORMS 2.0 with zenon you have to load straton
firmware on the Controller. This chapter will show you how to:

»  straton - load firmware on the Controller

» update already existing (on page 10) straton firmware or replace other already existing
firmware

» create a USB connection (on page 11) with the Controller with the COPA-DATA USB driver
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»

STRATON - LOAD FIRMWARE ON THE CONTROLLER

In order to load straton firmware on the LEGO MINDSTORMS NXT 2.0 Controller the LEGO

establish a Bluetooth connection (on page 12) with the Controller

MINDSTORMS NXT 2.0 software is required, which was delivered with your LEGO MINDSTORMS NXT

2.0.

AAttention

If on the Controller there already is a different firmware than the one delivered
by LEGO please proceed as described in section Dealing with already existing

firmware (on page 10).

In order to load the firmware;

1.
2.

Start the LEGO MINDSTORMS NXT 2.0 software.

In the Tool menu, select -> Update NXT Firmware.

Ensure that the correct format is used: *.rfw.
If the file suffix is still *.bin, change this to *.rfw.
Correct file name: STRATON_NXT_103_2011_08_10.rfw.

You can find this on the installation medium in the path: AdditionalSoftware\Science Package

- Firmware\NXT2.

Click on the Browse button.

Select the folder containing the firmware.

[5]] Update MXT Farmware s

LEGO HT Firmvears w105

D Orine Updenes: [ o]

5 avatatle Frmare s

J

Look INEINITsEamn

Brograw

Locating NaT Erwparing 4T Boveroad

v [~ Torowse for HT
I > Frmwan 4

Start the NXT Controller.

To do so, press the orange key.
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I@ Update NICT Firmware =
n;

Last dowenloaded firmware: LEGO MINDSTORMS KT Frmmars 105

| B orine usdees

(5] Avatable Femae Fies

‘ B

Connect the Controller via USB with the computer.

Click on the button Download to load the firmware on the Controller.

fenh

Vehicle:
3

9. Remove the USB cable.

10. The Controller starts with the updated firmware

¥ |Information

In order to update the loaded straton later on or replace it again with firmware
by LEGO follow the instructions in section Dealing with already existing firmware

(on page 10).

3.1.4 Dealing with already existing firmware

If firmware not provided by LEGO is already present on the Controller this has to be set to the
Firmware-Load-Mode in order to be able to install other firmware. This mode is also required if the
straton firmware is supposed to be updated or LEGO firmware loaded again. In order to set the
Controller to Firmware-Load-Mode:

1. Press for at least 5 seconds until you hear a quiet clicking noise

» Dboth the orange start key and

» the Rest button on the back of the device.
You can best reach the Rest button with a pointed object.
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2. Switch on the NXT Controller by pressing the orange key.

3. The NXT Controller starts in the Firmware-Load-Mode. You can hear a regular sound.

4. Start the download of the desired firmware.
To do so, a connection via USB (on page 11) or Bluetooth (on page 12) must be established.
For the USB connection with zenon/straton the COPA-DATA driver is required.

AAttention

The Firmware-Load-Mode can only be closed by downloading a firmware.

3.1.4.1 USB connection without LEGO firmware

If the firmware applied is not provided by LEGO probably the corresponding driver must be installed.
In this case the USB Controller is not recognized during the connection with the computer. To
establish a USB connection:

1. Open the System control -> System -> Device manager.
Double-click on Unknown device.

In the tab Driver click on Update driver.

The dialog for selecting the driver is opened.

Select Search the computer for driver software.

Select the folder containing the file Mindstorm_straton.inf .
A warning regarding the driver manufacturer is displayed.

Select Install driver nevertheless.

o o N o oA W N

The device can now communicate via USB.
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3.1.5 Establish a Bluetooth connection with the Controller

If the computer is provided with a Bluetooth port the connection with the Controller can also be
established via Bluetooth. In order to configure Bluetooth for the connection between computer and
Controller:

1.

© ® N o

10.

Switch on the LEGO Controller by pressing the orange key.

Press the orange key again.

Select Settings with the right gray arrow key.

Confirm selection by pressing the orange key.

Go to the menu for Bluetooth settings by using the gray keys.

a)
)
Q)

d)

O

Activate Bluetooth.
Assign a Bluetooth name.
Set the Bluetooth status to visible.

Leave the Bluetooth menu by clicking on the dark gray key.

Change to menu Connections.

Select Bluetooth using the gray keys.

Now the Controller can be found via Bluetooth.

Open the Bluetooth device manager on the computer.

)

Select Add device.
Windows will search for visible Bluetooth devices.
Select your MINDSTORMS NXT Controller from the list and click on Next.

The MINDSTORM  Controller requires to enter a password for establishing the
connection:
1234_ is suggested. Confirm the password by pressing the orange keys.

The password defined in the MINDSTORMS 2.0 Controller must also be entered on the
computer.

Click on Next.

The connection is being established and the drivers are being installed.
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11.

Double-click on the created Bluetooth device.

The installed device and the assigned COM port are displayed. Connect the zenon Logic
Workbench with this COM port or connect zenon with the stratonNG driver.

In order to adjust the port:

a) Click on properties.
b) Click on the Advanced button.

c) Change the port number according to your specifications.

3.2 Create a connection between zenon Logic and straton

In order to create a connection between zenon Logic and straton:

1.

Start zenon. The project MINDSTORMS is opened.

If you would like to open a different project or workspace open the workspace for the project
via the context menu for the workspace.

If you would like to create a new project:

a) select the file -> Project new

a) create a new zenon Logic project by first right-clicking on the node zenon Logic and
then selecting in the project tree zenon Logic Project new...

Open the zenon Logic project by double-clicking in the Workbench.

In the zenon Logic Workbench click on Tools -> communication parameter.

| Options...

Customize...

Generate Html Document...
Build Menitoring Application...
& History...
%4 Global Binding Editor
@ Compare Project

OPC Client

af | IEC61350 Client

Goose Client

Communication Parameters...

Buntime Parameters 3
Import...
Export...
Convert Program 3

Automation Script...
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4. The dialog Options with the tab Debug is opened in order to configure the connection.

5. Click on the button ... in order to open the dialog for the settings of the serial
communication.

Kemmunikationsparameter @
" Ethemet TCPAP
IP Adresse: Abbrechen
Part: Hife
+ Serielle Yerbindung
PC Part: Com1 -
Baudrate: 15200 hd
Paritat: Keine -
Stoppbits: 1 -

6. Configure the serial setting corresponding to the settings for the LEGO Controller.
Note: In this dialog only COM ports 1to 4 can be selected. However, in the dialog Options
tab Debug you can enter the COM port directly in to the field communication parameter.
Optionen @

' Zielsystem | Rurtime | Compler | Download Debug | Oniine Change | "c* 14 | ¥ |

I_ ProgramData‘\COPA-DATA\SQL2008R2\ac 39 Wed- ¥ 73-dcebbdda-ee ':J
Kommunikationsparameter
[EIE10) -
[TS Rurtime LI

Simudation for alle Projelde)
[ Simulateor immer im Kalstart Modus starten
Verbunden mit Runtime fur alle Projekte)
™ Bestatigen vor dem Stoppen der Applikation
™ Bestatigen vor Download
[~ Bestatigen vor OnlineChange
Beim Starten der Runtime fur alle Projekte)
* Vorschlag im “Kaktstart"-Modus zu starten

" Vorschlag mit geladenen RETAIN Variablen zu startten

Misc
[™ User-Aktionen wahrend Test aufzeichnen

Log-Datei anzeigen... |

[ Aiways open this tab

oK I Abbrechen | Hilfe: |

7. You will thus have configured the connection between zenon Logic and straton.

3.2.1 Add NXT driver in zenon Logic

In order to add the NXT driver in zenon Logic:
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1. In the project tree in the zenon Logic Workbench double-click on Fieldbus configuration.

2. Inthe window I/O driver click on the symbol or the command in the context menu for Add

configuration.

T e I
Gle Ede View dmet Projct Took Window Mep
a3 z 9 B Ma%E D B%A
Vorkspace
ot []
3 G &
3 Progams -
4 Pecpe
3 Sgneh
£ SohScope g
2 Sov a
(3 Swng Taties
B Fiktbus Cordgpasens >
%5 Bedeg Conkgrason
© o B
| Vo fina
39 Gib doives Fnd Nt
(3 Global vanabie: 1 Bt
& e B et Configummtion.

3. The dialog for configuration is opened.

3

|EC B1850 Serves incl GOOSE
Irberbus-S

MODBUS Master protocol
MODBUS Slave protocol
PROFINET |0 controller

PROFINET |0 device

Softhet ProfbusDP

shiaton bo 2enon Runtme conrection
Wago T53.87x 10-Systern / Thinkl0
a0 Lirm: Controar
Wiekwnstaphan slandaed - Chert

[ Wini32 Shased memoty

[Fiow

Add Configuration I ﬁ
(Choose a configustion _
0K

Hizcher CIF Profibus
Hizcher SYCON configu Carcel

| | [Hischer SYCON configrstion [ureversal] |
Hilscher SYCON net configuation [C) |
|EC BOST0 Slave
|EC 61850 Chent

4. Select the LEGO MINDSTORMS NXT 2.0.

5. There are three sections:

P NXT (Status)
» Drives

» Sensors

Clicking on the plus (+) before the section opens a subarea. For each of these sections

predefined variables can easily be created.

CREATE VARIABLES

Create the required variables:
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1. Right-click on the NXT, Drives or Sensors branch.

rdow  Help

a2 th Hl&N%e A BRd

] 10 Orivers

[ 7 ©8 LEGO Mindstoms NAT 20
o & T

B0 B O

2. Select Create variable in the context menu

DRIVES

"B Stshut
& Deves
"B PatA
"8 Pet B
“BPetC
B Sensors
"8 Pet
"8 Pet2
"8 Pet3

"8
u I Bropertes..

b

find...
M, Find Next

B loset Configuration..
&

]

o Insegt Variable.

B¢ Sort symbols

3 Ghd

Create vaniables

Cirl+G

B8R number

There are two versions: easy and advanced. As a start it is best to select easy and then Create variable.
Please find more information on the use of Advanced Variables in section Use of complex variables
(on page 38).

SENSORS

Before creating a variable in section Sensors a sensor type in field Type must be selected. To do so,

double-click on the field Value.

—-— —
i~ el

O Ma%e D Fad

O LE0 Mircbtores T 200
&

L LT
D STATUS_BETTERELTAGE
@ STATUS BATFERVSTATE
& SEATUS BLUETOTHSTATE
@ SLATUS LSESTATE
B STATUS RECRAREEALE
= STATUE ERRDA
B Dvves
A Fma
A rnp
3
&

dddiad
127dz

| Pt
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CONFIGURATION EXAMPLE:

2o 0% (akm

3.2.2 Connect NXT Controller

In order to connect the NXT Controller:

1. On the Controller select USB as connection medium:

a) Press the orange key.
a) Use the gray keys to go to the menu Settings and open it by pressing the orange keys.
b) Select Connection.

c) Select USB.
(If you would like to connect via Bluetooth select Bluetooth.)

2. Compile the zenon Logic project:
a) Right-click on mindstorms in the project tree.
b) Select Compile project in the context menu.
3. Go online:
a) Select the entry Online in the zenon Logic menu Project.

b) The request for download is opened:
No appication [

Do-you want to download the application now?

] M

c¢) Click on Yes.
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4. The project is online and you can watch how the sensors read values.

3.2.3 Controller basic settings

BASIC CONFIGURATION
1. Configure the communication settings (details see following section: Settings).
2. Activate or deactivate Bluetooth (details see following section: Connection).

3. In case of active Bluetooth: Assign a unique name for the Bluetooth communication.

OPERATION

SWITCH ON

In order to switch on the Controller press the orange key.

MENU NAVIGATION
»  Open menu: Press the orange key.
»  Close menu: Press the dark gray key.

» Navigate in the menu: Press the left or right gray arrow key. Select a menu entry with the
orange key. In order to leave a submenu without saving press the dark gray key.

SWITCH OFF
1. Select Turn off in the main menu and press the orange key.
2. Select an option:

a) Save: Saves all settings on the flash memory and closes the Controller. The currently
loaded straton application, retain data and the configuration (Connection, Volume) are
saved on the flash memory.
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b)

Q)

Don't save: The application is saved without saving data or configuration on the flash
memory.

Cancel: Saving is cancelled and the main menu opened.

During the next start the data saved last (straton application, retain data etc.) are loaded.

STRATON MENU

With the straton menu you can start or stop the loaded straton application. In order to open the
menu select the entry straton in the main menu.

STATISTICS

Statistics displays information on the currently running application. In order to display the
corresponding data select the entry Statistics in the main menu. The following is being displayed:

» the name of the loaded application

code size in kB

the execution time of the straton cycle

»
» database size in kB
»
4

the cycle latency in microseconds

MENU SETTINGS

In this menu the following is configured and displayed:

»  Versions: Information on the version used.

»  Bluetooth: Bluetooth activation or deactivation. Name and contacts can be managed.

»  Name: Enter a name for the Bluetooth device. The name should be unique in the
Bluetooth network.

P On/Off: Activates/deactivates Bluetooth at the Controller.

»  Visibility: Determines if the device is visible for other Bluetooth devices.

P Search: Starts search for Bluetooth devices. In order to add a device to the Bluetooth
contacts select it from the list of devices found.

» Contacts: Manage contacts. You can remove contacts (devices which may be connected)
or establish connections (e.g. for pairing).

CONNECTION

Select the connection to be used by the straton communication server. Connection for the
communication with the zenon Logic Workbench. The communication server also includes a
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MODBUS slave. The zenon driver for straton must also be connected with the communication server.

Possible options are:
» USB
»  Bluetooth: incoming Bluetooth connection

»  RS-485: RS-485 port with the parameters 775200, E, 8, 1

Attention: Using RS-485 deactivates the sensor port 4. Please also bear in mind that the

straton communication server protocol can only be used point-to-point.

P None: The communication server is not used.

VOLUME

Defines the volume of the built-in speakers. Valid values are 0 to 4, with:
» 0 switched off

P 4 Maximum

3.3 straton - Develop applications for NXT
The following restrictions apply for straton applications on LEGO MINDSTORMS 2.0:

STRATON RUNTIME:

P Maximum size of code: 26 kB

P Maximum size of straton database: 20 kB

Note: Size of code and database can be checked in the menu Statistics.

ZENON LOGIC WORKBENCH

»  Only COM ports 7 - 9 can be used. If a USB device or a Bluetooth COM port was assigned a
higher port number than 9 this has to be manually configured to a port number lower than

10.

» Inthe Workbench only ports COMT - COM4 can be selected. However, port numbers can be
entered directly into the parameter string, e.g. COM9:19200,N,8,1. (See also section Establish

connection between zenon Logic and straton (on page 13).)

Note: In case of a USB or Bluetooth connection it is sufficient to enter the port, e.g. COM5
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¥  |Information

Please find general information on the programming of LEGO MINDSTORMS
NXT 2.0 in the LEGO documentation.

3.3.1 Use NXT communication ports

NXT objects contain three communication ports which can be addressed by the straton application.

With the menu Settings (on page 18) one of these connections is selected for the communication
server. This connection can subsequently not be used out of the straton application (e.g. by a
MODBUS Master or a function block). However, if a MODBUS Slave configuration was added a
MODBUS Slave can use the configured port.

Please find further information on the use of the serial port in the straton program and on the
MODBUS I/O driver in the zenon Logic documentation. To do so, in the Workbench press F1 or use
the menu Help.

All ports which are not being used by the communication server can be used by the straton
application and are addressed as follows:

3.3.1.1 USB

The NXT component can be connected with a computer via the USB port. NXT is recognized as serial
connection by the computer.

The USB port can be addressed by the straton application by selecting USB as COM port.

r \
MODBUS Master Port [
" MODBUS on Ethemet oK
Address: 127.0.0.1 Cancel
Port: 502

Protocol:

& Serial MODBUS-RTU
Com, port: usa:

Delay between requests

Delay (ms): |0

¥ Try to reconnect after communication error
¥ Manage gagnostic info for slaves
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3.3.1.2 Bluetooth

The Bluetooth port can be used in two different ways:

1. For incoming connections:
in this case the connection is established from a remote device, e.g. a computer. In this case
the string BT is sufficient in order to use the Bluetooth port.

2. For outgoing connections:
NXT is configured in order to establish a connection with another Bluetooth device, for
instance another NXT object. In this case use a string beginning with BT and ending with the
name of the device, for instance: BT:NXT.
Note: The device to be addressed must already be contained in the Bluetooth contacts. In
order to manually add a device to the contacts start the Search (on page 18) and manually
establish the connection once. For the first contact a pairing is probably required.

3.3.1.3 RS-485 Port (serial)

NXT objects also contain a serial RS-485 port. It is however shared with sensor 4. Thus only the port
or the sensor can be used.

The RS-485 port is addressed via character string HS. With this the port is opened with the help of the
following parameter per default:

» Baud rate: 775200 bit/s
»  Parity: even

» Data bits: 8

» Stop bit: 7

ADAPT PARAMETER

If you want to adapt the communication parameters, add them after the colon separated by commas.
The order:

» Baud rate in bits/s
» Parity: N (none), E (even), O (odd), M (mark) and S (space)
» Data bits
» Stop bit

For example: HS:19200,N,8,1

Note: If you use the RS-485 port with MODBUS or the straton protocol, always set Data Bits to 8.
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3.3.1.4 Fieldbus

With straton NXT it is also possible to use the MODBUS Slave and MODBUS Master configuration.
Please find information on MODBUS in the zenon Logic documentation. To do so, in the Workbench

press F1 or use the menu Help. The use of NXT sensor and motor ports are configured in the LEGO
LEGO MINDSTORMS NXT 2.0 configuration.

E ] LEGO Mindstorms NXT 2.0

& 8 ra

- [ Status

E t STATUS_BATTERYWOLTAGE
= t STATUS_BATTERYSTATE
J @ STATUS_BLUETOOTHSTATE
3 d STATUS_USBSTATE

= oy STATUS_RECHARGEABLE
b @ STATUS_ERROR

-} @* Drives
C o Poth

@ FORT_A_AUTOSFEED
& PORT_A_TACHOCOUNT

f PoutB

0 PutC

= Senzors

B Poit 1: Touch senzor
& PORT_1_VALUE

0 Port 2 Ulrasonic sensor
& PORT_2 VALUE
@& PORT_2 INVALID

B Port 3 Light sensor [active]
& FORT_3_VALUE
& PORT_3_INVALID

= B Post 4; Colowr sensor

gy PORT_4_VALUE
& PORT_4_RED
& PORT_4_GREEN
y PORT_4_BLUE
& FORT_4_GRAY
@ PORT_4_INVALID
@ FORT_4_COLOR

3.3.1.4.1 Status variables

The following status variables are available:

EREG
E Status

@ STATUS_BATTERYWOLTAGE
@ STATUS_BATTERYSTATE
@ STATUS_BLUETOOTHSTATE
@ STATUS_USBSTATE
@ STATUS_RECHARGEABLE
@ STATUS_ERROR

» STATUS_BATTERYVOLTAGE: current battery charge in millivolt.

P  STATUS_BATTERYSTATE: Battery capacity.
Value: 0 to 4 (as displayed on the NXT display)

P STATUS BLUETOOTHSTATE: Bluetooth status

Values:
» O:.on
P T:visible

P 2 connected
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P 3 connected and visible
P 4 off

P STATUS_USBSTATE: USB status
Values:

P O disconnected
P 7. connected
» 2 operating

» STATUS_RECHARGEABLE: Status for rechargeable batteries
Values:

» O No rechargeable batteries existing
» T:rechargeable batteries existing

P STATUS_ERROR: Error code

3.3.1.4.2Drive Variables

The following variables are available for the drive:

o® Diives
B Poit: &
@ PORT_A_AUTOSPEED
& PORT_A_TACHOCOUNT

»  PORT_x_AUTOSPEED (SINT, Output): Defines the motor speed.
Values: from -700 to 700

» O Motor off
» -700: Maximum speed backward
» 700: Maximum speed forward

»  PORT_x_TACHOCOUNT (DINT, Input): Contains absolute number of motor revolutions in
angular degrees. 360° are one complete revolution per second. Valid values: from
-2,147,483,648 10 2,147,483,647.

COMPLEX VARIABLES

More complex drive operations are configured with more complex variables. Select them in the entry
Create advanced variables in the context menu.
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AAttention

Do not use the AUTOSPEED variable and the Advanced Variables at the same

time. Using them at the same time may result in an undefined behavior of the
drive.

o® Drives

F Port A

E Pot B
g PORT_B_TACHOCOUMNT
g PORT_B_BLOCKTACHOCOUNT
g PORT_B_ROTATIONCOUNT
W PORT_B_TACHOLIMIT
W PORT_B_FLAGS
W PORT_B_MODE
W PORT_B_SPEED
g PORT_B_ACTUALSPEED
W PORT_B_REGPPARAMETER
W PORT_B_REGIPARAMETER
W PORT_B_REGDPARAMETER
W PORT_B_RUNSTATE
W PORT_B_REGMODE
g PORT_B_OVERLOADED
W PORT_B_SYNCTURNPARAMETER

Please find a description on how to configure these variables in section Using complex variables (on

page 38).

3.3.1.4.3Color sensor variables

The following variables are available for the color recognition:

W= Senzors

1 Port 1: Colour sengor
gy PORT_1_WALUE
@y PORT_1_RED
g PORT_1_GREEM
& PORT_1_BLUE
& PORT_1_GRAY
@ PORT_1_INVALID
iy PORT_1_COLOR

»  PORT_x_COLOR (INT, Output): Defines the sensor mode.
» O Passive mode (measure brightness)
» 7:Red is being measured.
» 2 Green is being measured.
»  3:Blue is being measured.
» 4 All colors are being measured
» PORT_x_VALUE (INT, Input)
If the mode is passive, red, green or blue:
» A value between 0 and 255 defines the color intensity.

If the mode is all colors:
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» 1:black

> 2:Dblue

> 3:green

» 4 yellow

» Sired

» 6 white

PORT_x_RED: In the mode all colors the intensity of the color red is measured.
PORT_x_GREEN: In the mode all colors the intensity of the color green is measured.

PORT_x_BLUE: In the mode all colors the intensity of the color blue is measured.

PORT_x_GRAY: Brightness is measured

v v v WV

3.3.1.4.4Touch Sensor Multiplexer (HT)

The following variables are available for the touch sensors:

&= Sensors
[d @ Fort 1: Touch sensor multiplexer [HT]
& PORT_1_SWITCH1
& PORT_1_SWITCH2
& PORT_1_SWITCH3
& PORT_1_SWITCH4

When using the Hitechnic Touch Sensor Multiplexer up to four sensors can be connected with a NXT
port:

PORT _x_SWITCH1: Status of sensor 1
PORT _x_SWITCH2: Status of sensor 2
PORT _x_SWITCH3: Status of sensor 3

v v v WV

PORT _x_SWITCH4: Status of sensor 4

3.3.1.4.5Gyroscopic sensor (HT)

The LEGO MINDSTORMS 2.0 NXT Gyro Sensor gives information on the number of motor revolutions
and the direction of the revolutions. The revolutions are measured in angular degrees. 360° are one
complete revolution per second.
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After the start of the straton application the sensor is automatically calibrated during connection. To
do so, the current zero value is calculated. This takes about 200 ms. During this period of time the
sensor must not be moved.

[l Port 2 Gyroscopic sesnor [HT)

gy PORT_2_WALUE
@ PORT_Z_INVALID

» PORT_x_VALUE: Number of angular grades per rotation second
»  PORT_x_INVALID: Is TRUE if:
» the sensor is being calibrated

P the value cannot be read

3.3.1.4.6Digital Acceleration Sensor (HT)

The LEGO MINDSTORMS 2.0 NXT acceleration sensor includes a 3-axis accelerometer measuring
acceleration in the three axes x, y and z. The acceleration is displayed within the scope of -2g to +2g
with approximately 200 steps per g.

) | '

The acceleration sensor can also be used to measure the gradient in three axes. This is possible
because gravitation is perceived as acceleration. If the sensor is motionless in the normal horizontal
position the x-axis and y-axis, being horizontal, will be close to zero, while the z-axis' value will be
close to 200, corresponding to 1g. If the sensor is then inclined the other axes will also perceive
gravity and the z-axis' value will decrease. Since gravity is divided among the three part vectors the
gradient of the sensor can be determined.
[ Port 2: Digital Accelerometer sensor (HT)
& PORT_3 WALUE_ X
@ PORT_3 WALUE_Y

gy PORT_3_WALUE_Z
@ PORT_3_INVALID

P PORT x VALUE_X: Acceleration in direction of the x-axis
PORT_x_VALUE_Y: Acceleration in direction of the y-axis
PORT x VALUE_Z: Acceleration in direction of the z-axis

v v v

PORT x_INVALID: Set to TRUE if the data of the sensor cannot be read.
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3.3.1.4.7Digital Compass Sensor (HT)

The LEGO MINDSTORMS 2.0 NXT Compass Sensor contains a magnetic digital compass to measure
the earth's magnetic field and calculate a heading angle. The Compass Sensor can be connected to a
NXT port with a NXT standard cable and uses the digital I2C communication protocol. The current
heading is calculated to the next integral angular degree.

The HiTechnic Compass Sensor is influenced by local magnetic interferences, as is any other magnetic
compass, too. Metal objects such as motors, batteries or cables may cause magnetic interferences.
Local magnetic interferences may cause the compass to produce a heading deviating several degrees
from the current magnetic heading. This effect is called compass deviation. In order to correct this
deviation the HiTechnic Compass Sensor has a built-in calibration function correcting deviations and
saving these values in the compass.

The calibration is optional and usually not required during normal operation. In order to minimize the
need to calibrate install the compass in a distance of at least 10 to 15 cm (4 - 6 inches) to NXT and the
NXT motors.

In order to calibrate the compass in the program:

»  Select calibration mode.

»  Program your NXT object so that it rotates within a very narrow circle.
» It must rotate between 12 and 2 times (more than 360 degrees).
»

It must complete a full turn in approximately 20 seconds.

The compass will maintain the calibration settings until another calibration is made, even though it is
being unplugged.

El Port 4: Digital compass sensor [HT)
g PORT_4_VALUE
g PORT_4_INVALID
Wk PORT_4_CAL

» PORT_x_VALUE: Current heading in degrees.

0: North
»  PORT_x_INVALID: Set to TRUE if the data of the sensor cannot be read.
» PORT_x_CAL: (Display) Controls the calibration mode.

» TRUE: change to calibration mode

»  FALSE: change to measuring mode.

Note: In the calibration mode the sensor provides invalid data.
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3.3.1.4.80ther sensors

The following additional variables for sensors are available:

@ Sensors

| Poti: Coloursensar |

[l Poit 2 Sound sensor [dBA)
g PORT_2_WALUE
@ PORT_2_INVALID

» PORT_x_VALUE: sensor value, depends on sensor

» Sound dB

» Sound dBA

» Ultrasonic: distance in centimeters (cm)

» Temperature: temperature in Celsius centigrade (°C/10)
»  PORT_X_INVALID:

P TRUE: sensor is in error status

3.3.2 Functions

In order to select functions these must be located in the corresponding folder. Copy the Mindstorms

NXT folder from the HWDEF folder on the installation medium into the HWDEF  folder of you
straton installation.
For example: %ProgramData%\COPA-DATA\zenon8.207T1\straton\HWDEF\Mindstorms NXT

AN ]
1 Embedded HMI
[d Files
[ Hilscher CIF
[ Hilzcher CIF PE
3 IECE1850
[ Maths
(=l | Mindstorms NxT
I} BUTTOMEMAELE
I} BUTTOMNGET
1T DISPLAYERASE
I} DISPLAYLINE
T} DISPLAYPIXEL
I} DISPLAYSTRING
1T SOUNDFREQUENCY [*Flay a tone®)
1 Miscellaneous
3 Mo
[ PC_CE
3 FID
[ Plus!
[ Registers

The following functions are available:
» BUTTONENABLE (on page 30): straton takes over control of NXT keys.
» BUTTONGET (on page 30): Transmits information on which key was pressed.

r
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DISPLAYERASE (on page 31): Erases screen content.
DISPLAYLINE (on page 31): Draws a line.
DISPLAYPIXEL (on page 31): Draws a pixel.
DISPLAYSTRING (on page 31): Writes a string.
SOUNDFREQUENCY (on page 32): Sound output.

v v Vv Vv v

3.3.2.1 BUTTONENABLE

BOOL BUTTONENABLE (BOOL ENABLE)

During the activation with ENABLE and status TRUE the control is being passed on to straton using the
keys on the NXT object. The key status can be read with BUTTONGET (on page 30).

Note:
» The menu System on the NXT object is deactivated in this case.
»  Activating this function is only possible if the menu on the NXT object is inactive.

»  This status can be interrupted, for instance by a Bluetooth pairing dialog. In this case
BUTTONGET (on page 30) returns the value -T.

Response value:

»  TRUE: Activity successfully completed.

3.3.2.2BUTTONGET

SINT BUTTONGET

Return values:
» -7:Keys cannot be read by straton. The menu System on the NXT object is activated.
0: no keys pressed.
1: left key pressed.
2: Entry key (orange key) pressed.
3: right key pressed.

v v v Vv v

4: Leave (dark gray key) pressed.
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3.3.2.3 DISPLAYERASE

BOOL DISPLAYERASE
Erases the screen contents.

Response value:

»  TRUE: Activity successfully completed.

3.3.2.4DISPLAYLINE

BOOL DISPLAYLINE (USINT XT,USINT YT,USINT X2, USINT Y2, BOOL C)
Draws a line from point X1,Y1 to point X2,Y2.

Values for C:
P TRUE: draws a line
P FALSE: deletes the line

Response value:

»  TRUE: Activity successfully completed.

3.3.2.5DISPLAYPIXEL

BOOL DISPLAYPIXEL (USINT X, USINT Y, BOOL C)
Draws a point with the coordinates X,Y.

Values for C:
» TRUE: draws a point
»  FALSE: deletes the point

Response value:

»  TRUE: Activity successfully completed.

3.3.2.6 DISPLAYSTRING

BOOL DISPLAYSTRING(USINT X, USINT Y, STRING TEXT)
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Writes a string beginning with the indicated XY position.

Response value:

»  TRUE: Activity successfully completed.

3.3.2.7SOUNDFREQUENCY

BOOL SOUNDFREQUENCY(UDINT FREQ, UDINT DUR, USINT VOL)

Plays a tone with the indicated frequency in Hz during the defined length in milliseconds. The volume
(VOL) is indicated in a range of 1to 4. Itis limited by the configured maximum volume (on page 18) in
the menu Volume.

Response value:

»  TRUE: Activity successfully completed.

3.4 Connect MINDSTORMS 2.0 Runtime with zenon

For creating a new zenon Logic project in zenon it is recommended to use the stratonNG driver. This
supports serial communication.

When creating a new zenon Logic project in the dialog define the name of the project and the driver
used.

Create zenon Logic project

Settings
Name
MINDSTORMS

Drivers
STRATOMNNG W

Finish Cancel Help

Select STRATONNG from the drop-down list.

Note: The selection of the driver cannot subsequently be changed again.

CONFIGURATION OF STRATONNG DRIVER

To configure the driver:
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1. inthe zenon project tree select the node Variables -> Driver

2. highlight the stratonNG driver
Note: this is displayed with the name defined for the project, e.g. straton: mindstorms

3. select Driver configuration in the context menu

4. the dialog for the driver configuration is opened

5. open the tab Connections
Konfiguration
Allgemein | Options | Connections
Connections Edit connection | oK )
Connection name
Connection name ; 1 Abbrechen
‘ [ e
Addressing
Primary IP address Primary port no.
Secondary IP address Secondary port no
Emror handling
Comunication timeout Reconnect delay

ms ms

Options

Use muttiple connections

Use evert connection

Max. write request length
12

New Delete Edt !

To edit the driver:
1. highlight the connection name
2. click on Edit
3. configure the link

4. click on Save and then OK

Configuration of the driver for the connection within the scope of LEGO MINDSTORMS 2.0:

N

Connection name Must correspond to the project name.

If the name is different from that of the project this will result in
errors during the connection with the Controller.

Adressing In the communication with straton NXT via USB or Bluetooth it is
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o [

sufficient to set the port without further settings, e.g. COM5:
Primary IP address Entering COM port.

Entries beginning with COM and ending with a colon are interpreted
as COM ports.

Attention: The colon (:) must be present at the end of the port
definition. Otherwise it is not possible to establish a connection.

If no further parameters are indicated the standard configuration of
the COM port is used:

» Baud rate: 775200 bit/s

» Parity: even

» Data bits: 8

» Stop bit: 7
If you want to adapt the communication parameters, add them after
the colon separated by commas. The order:

» Baud rate in bits/s

» Parity: N (none), £ (even), O (odd), M (mark) and S (space)

» Data bits

» Stop bit

For example: COM5:19200,N,8,1

Limitations: If a COM port is indicated it is not possible to use:
» Event connection

» Multiple connections (more than one connection with a driver)

The documentation of these settings refers to the communication in the scope of LEGO
MINDSTORMS 2.0. Please find details on the general configuration of the stratonNG driver in the
online help (F1) in chapter stratonNG.

3.5 Questions and answers

The most common questions regarding installation and operation of LEGO MINDSTORMS with
straton and the zenon Science Package.

Question Answer

Why is an error message displayed during  Probably there is already a zenon installation
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installation?

How do | change back to the original LEGO
firmware?

How can | proceed if the LEGO Firmware
Loader does not find the Controller?

How do | proceed if the zenon Logic
Workbench driver does not communicate
with my Controller?

How do | proceed if the stratonNG driver
does not communicate with my Controller?

Further questions and answers can also be fou
www.copadata.com/forums (https://forum.cop

3.5.1 Error message during the in

An error message is displayed during the insta
MINDSTORMS which refers to an already existi

HINT -~ 2

. The zenon development environment is already installed on this
computer. You cannot install it again!
You can adapt the installation in the Windows Control Panel in the
section Software.

OK

Answer

present in the system.
Use the existing installation.

Details: Error message during the installation of the
zenon Science Package (on page 35).

Changing back corresponds to the proceeding
during the installation of the straton firmware if
other firmware already exists.

Details: Activate original LEGO firmware (on page
36).

Change the USB port or re-install its driver.

Details: LEGO Firmware Loader does not find the
Controller (on page 37).

This may have several causes. Check the settings
and if all devices are online.

Details: zenon Logic Workbench driver does not
communicate with the controller (on page 37)

This may have several causes. Check the
communication parameters, the Runtime and the
project.

Details: stratonNG driver does not communicate
with the controller (on page 38).

nd in the COPA-DATA user forum:
adata.com/).
stallation of the zenon Science Package

llation of the zenon Science Package for LEGO
ng installation.
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This zenon version has already been installed on your system. You don't have to install zenon and can
use the existing version. Import the demo projects (on page 8) from the installation medium and
continue with Install firmware (on page 8).

3.5.2 Activate original LEGO firmware

If firmware not provided by LEGO is already present on the Controller this has to be set to the
Firmware-Load-Mode in order to be able to install other firmware. This mode is also required if the
straton firmware is supposed to be updated or LEGO firmware loaded again. In order to set the
Controller to Firmware-Load-Mode:

1. Press for at least 5 seconds until you hear a quiet clicking noise
» both the orange start key and

» the Rest button on the back of the device.
You can best reach the Rest button with a pointed object.

3. The NXT Controller starts in the Firmware-Load-Mode. You can hear a regular sound.

4. Start the download of the desired firmware.
To do so, a connection via USB (on page 11) or Bluetooth (on page 12) must be established.
For the USB connection with zenon/straton the COPA-DATA driver is required.

AAttention

The Firmware-Load-Mode can only be closed by downloading a firmware.

DOWNLOAD OF THE LEGO FIRMWARE:
1. Connect the Controller via USB with the computer.

2. Start the LEGO MINDSTORMS NXT 2.0 software.
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In the Tools menu, select Update NXT Firmware.
The original LEGO MINDSTORMS NXT firmware is preselected.

Click on the Download button.

S v~ W

The Controller restarts with the original LEGO firmware.

3.5.3 LEGO Firmware Loader does not find the Controller

If the LEGO Firmware Loader does not find the Controller connect the USB cable with a different USB
port By doing so the USB driver is installed for the Firmware Loader mode.

If this does not solve the problem deinstall the driver. To do this:
1. Open the device manager in the system control while the Controller is connected.
2. Select the LEGO MINDSTORMS NXT Firmware Update Mode driver.
3. Right-click on it.

d

PET—

4. Select Deinstall in the context menu.
5. Remove the USB cable from the LEGO MINDSTORMS 2.0 Controller and reconnect it.

6. The driver is automatically reinstalled.

3.5.4 zenon Logic Workbench driver does not communicate with the
Controller

The communication with the Controller is a point-to-point communication via a virtual serial port. It is
only possible to connect one application at a time.

If the communication fails there might be several reasons. The most frequent include:
1. The stratonNG driver and zenon are still online.

2. The COM port settings are incorrect. Select the correct COM port settings in the menu
Communication parameters (on page 18).
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3. The connection settings for the Controller are not set to the correct medium (USB or
Bluetooth). Select the currently used connection.

3.5.5 stratonNG driver does not communicate with the Controller

The communication with the Controller is a point-to-point communication via a virtual serial port. It is
only possible to connect one application at a time.

If the communication fails there might be several reasons. The most frequent include:
1. The zenon Logic Workbench is still online.
2. The COM port settings are incorrect.

3.  The straton Runtime has not been started on the LEGO MINDSTORMS 2.0 Controller.
In order to start the Runtime:

a) Press the orange key.
b) Assoon as you see the entry straton press the orange button again.
C) Select Start and press the orange key.

You can tell that the Runtime is running when the square symbol next to the battery status is
rotating.

4. The straton project was not downloaded to the Controller.
If a project was downloaded please check if it is the correct project.

5. The symbol names of the variable have not been activated.

6. The connection name (on page 32) of the stratonNG driver is not identical with the name of
the zenon Logic project.

7. The connection settings for the Controller are not set to the correct medium (USB or
Bluetooth). Select the currently used connection.

3.6 Use of complex variables

This section explains how to control a motor with complex variables.
¥ Information

The use of complex variables is only recommended for experienced users!

With an additional programming you can make the NXT motors move by a predefined angle. This is
required in order to engineer very precise movements. For engineering:
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1.

2.

Create all variables by right-clicking on the port and selecting Create advanced variables in
the context menu.

[F] LEGO Mindstotms NXT 2.0

g

2 B w1

ol o* Drives

8 9 @ PotA

o= ] o

g O Por: B Properties...

g @ Sensors

3 m Pot &

@ o Pot &
B Por

B o Pot

Find...
#, Find Next
[8  lnsert Configuration..
i
& Insest Variable... |

N,
e, B¢ Sort symbols
3 Grid Ctris G

Create variables

Create advanced variables

You receive 15 variables.

The variables relevant for you are:

»

PORT_n_FLAGS

»  Bit mask from which variables should be written.

PORT_n_TACHOLIMIT

» The relative limit for the degrees with which the motor is supposed to rotate.
» Attention: This value is always positive, even if the motor rotates backwards.
PORT_n_MODE

» Mode the motor is supposed to use.

» Does not refer to forward or backward or increasing or decreasing speed, but to internal
commands.

PORT_n_SPEED

» Motor speed.

» Range: -700 (backward) to 700 (forward)
PORT_n_RUNSTATE

» How the motor is supposed to run.

» Physical properties  (set speed instantly, Ramp UP or Ramp DOWN)
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AAttention

All variables must be written in a cycle!

That means: The variables cannot be forced from the zenon Logic Workbench.

STRUCTURE

Internally, NXT uses a structure. Create all variables of this structure by right-clicking on the port and
selecting Create advanced variables in the context menu. This structure is written in every cycle.
However, since PORT_n_FLAGS is set by straton to 0  after each cycle nothing else will happen.

The variable PORT_n_Flags is a bit mask for those variables which are relevant in this cycle for the
structure straton queries. In order to give a Move n degreecommand set the PORT_n_FLAGS variable
to a bit mask [ST]:

Set F variables
FORT_B_FLAGS := any to_usint (UPDATE_MODE or UPDATE_SPEEC or UPDATE_TACHO LIMIT):

It is then defined that the data for PORT_n_MODE, PORT_n_SPEED and PORT_n_TACHOLIMIT are
available. Which values must these variables have?

For PORT_n_MODE also a bit mask is required. In principle always both must be set if you would like
to create a forward movement [ST]:

MOTORON
BRAKE

asint (HOTORCH or BRAKE):

Now you have set the bit mask on which variables are supposed to be updated as well as some
internal flag parameters.

Now we can focus on the more interesting part: The rotation mode of the motor -
PORT_n_RUNSTATE. No bit mask is available in this case. The values are exclusive.

$#define MOTOR_RUN_STATE_IDLE - Motor idles does nothing
$define MOTOR_RUN_STATE_RUNNING 163%

PORT_B_RUNSTATE := any_to_usint (MOTOR_RUN_STATE_RUNNING);

And finally: PORT_n_SPEED And PORT_n_TACHOLIMIT:

//Full force 360 degree foreward turn
PORT_B_SPEED e :
PORT_B_TACHOLIMIT := 360;

AAttention

Make absolutely sure that these values are not written in every cycle. Otherwise
the rotation command is executed in every cycle. However, you still have to
write all variables in every cycle. Block the writing of these values.
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4 zenon Science Package for LEGO MINDSTORMS EV3

The zenon Science Package for LEGO MINDSTORMS EV3 enables the programming of LEGO
MINDSTORMS EV3 objects.

Preparation:

zenon 7.20 already installed and installations medium available.
If you have not installed zenon, you have to install zenon Science Package for LEGO MINDSTORMS,
version 7.20 or higher.

4.1 Requirements
Hardware:

» Netgear WNAT1100 Wi-Fi Dongle

» LEGO MINDSTORMS EV3 with firmware version 1.03E or 1.03H or higher.
Software:

P zenon from version 7.20 on

» LEGO MINDSTORMS EV3 Runtime (available on the installation medium in the path
\AdditionalSoftware\Science Package - Firmware\EV3)

»  Bricx Command Center (available at http://bricxcc.sourceforge.net/
(http://bricxcc.sourceforge.net/))

FIRMWARE FOR LEGO MINDSTORMS EV3
The firmware on the LEGO MINDSTORMS EV3 must be at least version 1.03E or 1.03H or higher.

To check the version of the firmware, select Brick Info in the Settings tab of LEGO MINDSTORMS EV3.
You can download the most recent firmware (*.bin file) from the LEGO website.

Use the LEGO software to update the firmware.

4.2 Installation
The installation comprises:
» zenon Science Package

> EV3 Setup
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»

zenon Logic Editor and Runtime

If you have already installed zenon 7.20 or higher, you can execute the EV3 setup immediately.

INSTALLATION OF THE ZENON SCIENCE PACKAGE

Start the installation from the zenon installation medium and follow the notes in the installation
assistant. You can also download the zenon Science Package from the COPA-DATA home page. This
installation already includes zenon Logic.

INSTALLATION OF STRATON RUNTIME ON LEGO EV3

1.

Install the Bricx Command Center.
You can find the program at http://bricxcc.sourceforge.net/test_releases
(http://bricxcc.sourceforge.net/test_releases).

Download a current test_release.
test_release2013007.zip is used in these instructions.

Connect the LEGO MINDSTORMS EV3 to the PC with a USB cable.
Open Bricx CC: Tools -> Find Brick

Configure the connection:

Find Brick I-®

Searching for the brick |
Poeat Eirick Typs )
ush - [ea = |

Firnwiase
Standard
leJOS @) Linuc

0k [ Cocel |[ Hep |

L

» Port: usb
» Brick Type: £V3
»

Firmware: Linux

Open Bricx Explorer: Tools -> Explorer.

Create a new folder called T5 Runtime.
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8. Open, on the installation medium, the folder T5 Runtime in the following
path:\AdditionalSoftware\Science Package — Firmware\EV3\apps.

9. Copy the files contained therein and add these to your T5 Runtime- folder in the Brick

Explorer.

10. Open the \AdditionalSoftware\Science Package — Firmware\EV3\prjs folder on the installation
medium.

11. Copy the file there called t5ev3 to the folder in which the T5 Runtime folder is also located.

File Edit View Help
xFN da> @0 L8
Alfes 9 bt

.
4 BrkProg_SAVE
X EVIMEG 4
& TS Rurame # ) CE

sev: 3 ) HELP

»  Onthe LEGO EV3 Brick, the new entry T5 Runtime is now available.

e

4.3 Create a zenon Logic project

zenon Logic contains a fully-integrated configuration tool for the LEGO MINDSTORMS EV3, as well as
a library with Functions and Function Blocks.

The first stage is to create a zenon project and a zenon Logic project in this.

CREATE A ZENON PROJECT
1. Open the zenon Editor

2. Select File -> New project.
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3. The dialog to create a project is opened.

i
i
I

4. Enter a name for the project.
5. Click on OK.
» The wizard to create the project is started.

P Close the wizard.

Alternatively, you can also open the supplied demo project.

CREATE A ZENON LOGIC PROJECT
1. In the zenon Editor, go to zenon Logic (IEC 61131-3).

2. Inthe context menu or in the toolbar of the detail view, select zenon Logic New project.

= <
A Epapmant msdebng w | Dtoal /0 fittered ¢ 0 setected

3. The dialog to create a project is opened.
4. Enter a name for the project.

5. Click on Finish.
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4.4 EV3 configuration in zenon Logic

Runtime administers an allocation table, which contains the LEGO MINDSTORMS EV3 Inputs and

Outputs. A tool for configuration is integrated into the zenon Logic Workbench.

To start the configuration:

1. In the zenon Logic Workbench, double click on Field bus configuration.

) MyEV3
3 Graphic
33 Programs
[ Recipe
3 Signals
3 Soft Scope
3 Spy
[ Sting Tables
i Fieldbus Configurasions
%} Binding Configuration
€ Profiles
i yos
29 Global defines
4 Verisbles
B Types

The 1/0 driver window is opened.
Right click on a free position in this window.

Select Add configuration in the context menu.

A A

The Add configuration window is opened.
. ddConfiguatn  EX

Choose a configueation

jr _______________|

Ay Cancel
=

DNPY

oK

EthemetiF
IEC 0570
IECH1E50
MODBUS
Frafinet 10
Shared Memary

6. Select the All node.
7. Select LEGO EV3.
8. Click on OK.

The configuration is created in the tree view:

=-[ LEGO EV3
B[] Eva
ﬂ Buttonz
£ Sensars
B Partd

LEGO EV3 CONFIGURATION
» EV3
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» Buttons
Sensors

» Port0
» Port1

» Port2
» Port3

4.4.1 Define sensor type

You can define the type of sensor for each port in the Sensors group.

Double-click on the port.

The configuration window will open

Double-click on Type.

The selection list is opened.

Select the desired type.

Yo T

g Touchsensor _________|#8

Sound sensor (dB)
Sound sensor (dBA)
Light zensor (active)
Light sensor (ambient)
Colour sensor
Ultrasonic sensor
Temperature sensor
Gyroscopic sesnor (HT)
Digital compass sensor (HT)
EV3 Gyroscopic sensor
EV3 Ultrasonic sensor

EW3 Colour sansor
w

To do this:
1.
2.
3.
4.
5.
-
6.

Close the dialog by clicking on OK.

4.4.2 Create variables

You can create variables automatically or connect them manually.

CREATE VARIABLES AUTOMATICALLY

1.

2.
3.

Note: If the sensor type is set to None, no variables are created.

Right-click on the port.

Select Create variables in the context menu.

All required variables are created automatically.
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CONNECT VARIABLES MANUALLY

To connect variables manually:
1. Right-click on the port.
2. Select Add variables in the context menu
3. The dialog for configuration is opened.

4. Clicking on a value opens the selection list of the values that are possible for this type.

CONFIGURE VARIABLES
Symbol Selection of a variable in accordance with IEC 61131-3 syntax.
Area Range.
Format Data type:

» 32 bit float

» Signed 16 bit integer

» Signed 32 bit integer

» Signed 8 bit integer

» Single bit

» Unsigned 16 bit integer
» Unsigned 32 bit integer
» Unsigned 8 bit integer

Offset Is not used.
Bit Number Bit number.
DATATYPES

You can connect variables with any desired data type to the LEGO EV3  I/Os. Runtime automatically
converts the values to the data type of the variable.

Note: STRING variables are not supported.

4.4.3 Blocks and Functions function

Some Function Blocks and Functions are provided in the library to control LEDs, sounds, LCD and
motors of the LEGO EV3.
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The following Function Blocks are described in more detail:

» LED
» Sound
» Motor

4.4.3.1LED

Set LED pattern:

SetlLed Creates an LED pattern

[IN] LED Index of the LED pattern to be applied:
» 0O All LEDs off.
» 7-9: Corresponding LED pattern.

[oUT] Q Current LED pattern.

4.4.3.2Sound

Set sound playback.

General:
PlaySnd Play back sounds.
[IN] ENABLE Switch on sound playback:
» TRUE: Sounds are played back.
To activate playback, the setting must have previously been
FALSE.
» FALSE: Sounds are not played back.
[IN] FREQ Frequency of the sound.
[IN] DURATION Duration of the signal.
[IN] VOLUME Volume

»  Minimum: 0

»  Maximum: 700
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[OUT] PLAYING TRUE, if sounds are played back.

System sounds:

PlaySysSnd Play back system sound.

[IN] ENABLE Switch on sound playback:

» TRUE: Sounds are played back.
To activate playback, the setting must have previously been
FALSE.

» FALSE: Sounds are not played back.
[IN] SND Index of the system sound.

[IN] VOLUME Volume.
»  Minimum: 0

»  Maximum: 700

[OUT] PLAYING TRUE, if a system sound is played back.
Symbol Variable name in accordance with IEC 61131-3 syntax.
Area » Data Exchange

» Data Status.

Format Data type:
» 32 bit float
» Signed 16 bit integer
» Signed 32 bit integer
» Signed 8 bit integer
» Single bit
» Unsigned 16 bit integer
» Unsigned 32 bit integer
» Unsigned 8 bit integer

Offset Is not used.

Bit Number Bit number.
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4.4.3.3Motor

Set motor.

MOTOR INFORMATION

Motor information:

Motorinfos Call up motor information.

[IN] MOTOR Index of the motor: 7 - 4

[OUT] SPEED Current speed.

[OUT] TACHO Current number of revolutions to display the distance covered.
RUN MOTOR

Run a motor:

Rotate Run a motor.
[IN] MOTOR Index of the motor: 7 - 4
[IN] START Start motor:

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.

[IN] POWER Force to be applied:
» -255to -T. Backwards.
» O Stop.
» 7to 255 Forward.

[OUT] RUNNING TRUE if the motor is running.
[OUT] SPEED Current speed.

Run several motors:

Rotate2 Run several motors.
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[IN] MOTORS Index of the motor numbers.
» Motor 1.7
» Motor 2: 2
» Motor 3: 4
» Motor4: 8

Example: To address Motors 7 and 2, enter 3 (1 + 2).

[IN] START Start motor:;

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.
[IN] POWER Force to be applied:
-255 to -T: Backwards.
0: Stop.
1 to 255: Forward.
[OUT] RUNNING TRUE if the motor is running.

[OUT] SPEED Current speed.

ROTATION ANGLE

Rotation angle for a motor:

RotateAngel Rotation angle for a motor.
[IN] MOTORS Index of the motor: 7 - 4
[IN] START Start motor:

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.

[IN] POWER Force to be applied:
» -255to -T: Backwards.
» O Stop.
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[IN] ANGLE

[IN] BRAKE

[OUT] RUNNING

[OUT] SPEED

» 7to 255 Forward.
Angle in degrees.

Brake.
» TRUE: Motor is braked at the end.
» FALSE: Motor is not braked.

TRUE, if the motor is running.

Current speed.

Angle of rotation for several motors:

RotateAngel2

[IN] MOTORS

[IN] START

[IN] POWER

[IN] ANGLE

[IN] BRAKE

Angle of rotation for several motors.

Index of the motor numbers.

» Motor 1.7
» Motor 2: 2
» Motor 3: 4
» Motor4: 8

Example: To address Motors 7 and 2, enter 3 (1 + 2).

Start motor:

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.

Force to be applied:
» -255to -T. Backwards.
» O Stop.
» 7to 255 Forward.

Angle in degrees.

Brake.
» TRUE: Motor is braked at the end.
» FALSE: Motor is not braked.
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[OUT] RUNNING TRUE, if the motor is running.
[OUT] SPEED Current speed.
SPEED

Speed for a motor:

RotateCount Run a motor for a defined number of counter impulses.
[IN] MOTORS Index of the motor: 7 - 4
[IN] START Start motor:

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.

[IN] POWER Force to be applied:
» -255to -T: Backwards.
» O Stop.
» 7to 255 Forward.

[IN] COUNT Number of rotation impulses.
[IN] BRAKE Brake.
TRUE: Motor is braked at the end.
FALSE: Motor is not braked.
[OUT] RUNNING TRUE, if the motor is running.
[OUT] SPEED Current speed.

Speed for several motors:

RotateCount2 Run several motors for a defined number of counter impulses.
[IN] MOTORS Index of the motor numbers.

» Motor 1.7

» Motor 2:2
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» Motor 3: 4
» Motor4: 8

Example: To address Motors 7 and 2, enter 3 (1 + 2).

[IN] START Start motor:

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.

[IN] POWER Force to be applied:
» -255to -T: Backwards.
» O Stop.
» 7to 255 Forward.

[IN] COUNT Number of rotation impulses.

[IN] BRAKE Brake.
» TRUE: Motor is braked at the end.
» FALSE: Motor is not braked.

[OUT] RUNNING TRUE, if the motor is running.
[OUT] SPEED Current speed.
RUNNING TIME

Running time for a motor:

RotateTime Run a motor for a defined time period.
[IN] MOTORS Index of the motor: 7 - 4
[IN] START Start motor:

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.

[IN] POWER Force to be applied:
» -255to -7: Backwards.
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» O Stop.
» 7to 255 Forward.

[IN] SECONDS Time that the motor runs, in seconds.

[IN] BRAKE Brake.
» TRUE: Motor is braked at the end.
» FALSE: Motor is not braked.

[OUT] RUNNING TRUE, if the motor is running.
[OUT] SPEED Current speed.

Speed for several motors:

RotateTime2 Run several motors for a defined time period.
[IN] MOTORS Index of the motor numbers.

» Motor 1.7

» Motor 2:2

» Motor 3: 4

» Motor4: 8

Example: To address Motors 7 and 2, enter 3 (1 + 2).

[IN] START Start motor:

» TRUE: Motor is started. To start, the setting must have
previously been set to FALSE.

» FALSE: Motor is not started.

[IN] POWER Force to be applied:

» -255to -T. Backwards.

» 0. Stop.

» 7to 255 Forward.
[IN] SECONDS Time that the motors run, in seconds.
[IN] BRAKE Brake.

» TRUE: Motor is braked at the end.
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» FALSE: Motor is not braked.
[OUT] RUNNING TRUE, if the motor is running.

[OUT] SPEED Current speed.

MOTOR POWER OUTPUT

Define the power output for a motor:

SetPower Define the power output for a motor whilst it is turning.
[IN] MOTORS Index of the motor: 7 - 4
[IN] SET Define power output:

» TRUE: Power output is defined. To do this, the setting must
have previously been set to FALSE.

» FALSE: Power output is not changed.

[IN] POWER Force to be applied:
» -2551to -T. Backwards.
» O Stop.

» 7to 255 Forward.

Define power output for several motors:

SetPower2 Run several motors for a defined time period.
[IN] MOTORS Index of the motor numbers.

» Motor 1.7

» Motor 2:2

» Motor 3: 4

» Motor 4: 8

Example: To address Motors 7 and 2, enter 3 (1 + 2).

[IN] SET Define power output:

» TRUE: Power output is defined. To do this, the setting must
have previously been set to FALSE.
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» FALSE: Power output is not changed.

[IN] POWER Force to be applied:
» -255to -T: Backwards.
» O Stop.
» 71to 255 Forward.

STOP MOTOR

Stop a motor:
StopMotor Stop a motor.
[IN] MOTOR Index of the motor: 7 - 4
[IN] STOP Motor is stopped.

Stop several motors:

StopMotor2 Stop several motors.
[IN] MOTORS Index of the motor numbers.
» Motor 1.7
» Motor 2:2
» Motor 3: 4
» Motor 4. 8

Example: To address Motors 7 and 2, enter 3 (1 + 2).

[IN] STOP Motors are stopped.

4.5 Connect EV3 to zenon Logic Editor
LEGO MINDSTORMS EV3 and zenon Logic communicate via Wi-Fi.

To establish communication:

1. Insert the Netgear WNA1100 Wi-Fi Dongle into the USB port of the Brick.
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2.

Switch on the Wi-Fi on the LEGO MINDSTORMS EV3.

To do this:

a) Open the Settings tab (tool symbol).

b) Activate the Wi-Fi.

Connect to your network.

You can find further information about Wi-Fi in your LEGO MINDSTORMS EV3 instructions.
Define the IP address of the LEGO MINDSTORMS EV3 in zenon Logic Editor.

To do this:

a) Open the Tools menu.

@) O

(oN

59) chapter.)

) Select the Communication parameters command.
) The dialog to select the IP address is opened.
) Select the IP address of the EV3. (See also the First steps in the demo project (on page

Communication Settings l

===

L
o

1921681131100
192168.33111:502
192 168,33 45:502
192 168,33 46:502
19216833 5:502 -
152 16833 88:1100

152168.73.114:1100

152168.73.1151100

[ Comel |

Heip

!

Note:

- You can find the correct IP address in the Brick in the Settings tab (tool symbol ) under

Brick Info.
- Runtime uses port 7700.

Start the T5 Runtime on the LEGO MINDSTORMS EV3.

To do this:

a) Select, in the App tab (arrow symbol) of the Brick, T5 Runtime.

b) Press the middle switch on the Brick.
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¢) Starts the Runtime.

You can now create a new program in the zenon Logic Workbench to control your LEGO
MINDSTORMS EV3 EV3 with the help of the program.

4.6 First steps in the demo project

You can try out the basic functions and configuration of LEGO MINDSTORMS EV3 with zenon and
zenon Logic with the supplied demo project.

To do this:
1. Open the demo project called EV3_DEMO in zenon Editor.

2. Connect the sensors and motors to the corresponding ports.

3. Configure the zenon Logic: LEGO_EV3 driver.

CONFIGURING THE DRIVER

To configure the driver:

1. In the zenon project, go to the Driver node (below Variables).
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5.

Right-click on the driver zenon Logic: LEGO_EV3.

Select Driver configuration in the context menu

e
]

-

i

(EC 61131.3)
aclity Scheduder

H

i

i
i

[0 | PR T > CPE=R0A

i
il

i
it

Detete simulation project
Detete

Remore il filters

Edit selectea cel

Replace text In selected colamn..
Properties

Help

The configuration window will open

v V| et
Drives for internal vaniables Intern.
Driver for mathematics varisbles MATHDRR
Driver foe system varisbles SYSORV
SMUL SV

New ariver...
Exchange drives.

A, Driver configuration...
Import variables from driver...
Create/ednt simulation project

I

In the General tab, select the Hardware entry for the Mode option.

Zenon
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6. Switch to tab Connections (1).

a) Highlight the LEGO_EV3 connection (2).
b) Click on Edit (3).

c) For the Primary IP address option, enter the IP address of your Brick.
You can find the address in the Brick in the Settings tab (tool symbol) under Brick Info.

d) Change the Primary port no option (4) to 7700.
e) Confirm the input by clicking Save (5).
7. Close the window by clicking on OK.

CONFIGURE ZENON LOGIC PROJECT AND START RUNTIME

Once you have configured the driver, open the zenon Logic project.
To do this:

1. In the zenon Editor, go to zenon Logic (IEC 61131-3).
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2. Double click on the project

T et Omment Windew el

.V?

49-;.!
i

"

i

3. Open, in zenon Logic Workbench, the Tools menu.

4. (Click on Communication parameters.

File Edt View et vm,'-ul!lw’m Help
ok YT i

% Gptions_. Qo
Cuntomniae...

Geperate Himd Detument..
Buid Monitoring Application .
® Hiton..
W Global Bnding Edior
| Cempare Praject
0BC Chent
f ECH1850 Chent
Geede Cheng

Funtime Parsmeters v
Import...

Expart..

Camygert Prageam

suneenation Serpt..

5. The dialog to configure communication parameters is opened.
(See also Connect EV3 to zenon Logic Editor (on page 57) chapter.)

[T v]

|1?2.1s.1?2.12?:1100 ||:|

6. Enter the IP address of your LEGO MINDSTORMS EV3 Brick and its port number.
Format: IP address port number.
You can find the address in the Brick in the Settings tab (tool symbol) under Brick Info.
Port number: 7700.
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7. Use straton Runtime to connect to the EV3.
to do this:

» Open the menu Project

Select the Online entry.

4
» Confirm the question after downloading the project with OK.
4

Load the project into the EV3.
(Alternatively: Project -> Download application.)

8. Switch to the zenon Editor

9. In the Runtime files tool bar, click on Create all Runtime files.

10. Click on Start Runtime.

E
File Edit Options Window Help

e N ST NI S ST I Y TR T e Iy |

R ER YD A s

= IﬂE Workspace: 'SciencePackage_Demo_7_2012) %ﬁ;\ A ’ él ﬁnl:II. = | #
--[B) EV3_DEMO (Start project)
5 “ Variables State| Project name Target
23 Driver e e
# Datatypes [EGO EV3 73
+-@8 Reaction matrix

W Alocations
AT Alam

EV3 Runtime is started.

4.7 COPA-DATA Forum

For questions in relation to zenon Science Package for LEGO MINDSTORMS, you can also receive

information and support in the Science Package Thread in the COPA-DATA Forum:

www.copadata.com/forums (https://forum.copadata.comy/).
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